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This file details all program enhancements and revisions. 
 

For the most recent changes, scroll to the end of the file. 
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QuikEC3 release 0.01                                                 13-04-07 
 

QuikEC3 is a new program for steel design to EC3. Like Merlin which operates in accordance with BS5950, 
QuikEC3 is delivered with highly comprehensive tables of sections to British, European, American and Japa-
nese standards and like Merlin the designer may create his own custom section shapes, even welded and com-
pound. 

Because Eurocode is new to most engineers the focus of QuikEC3 over Merlin is changed to emphasise detail 
and clarity. It has been developed not just as a serious design office tool, but as a learning aid. 

At the time of writing, not all the parts of Eurocode are published, the bulk of QuikEC3 refers to: EN1993-1-
1:2005 General rules and rules for buildings whose national annex is not yet available. It is expected that this 
annex will contain considerable guidance and may override some clauses and methods. 

Consequently, this release of QuikEC3 is being offered as a guidance, learning and familiarisation tool. There 
is no better way of examining the consequences of Eurocode. 

QuikEC3 release 0.01 runs under all versions of Windows from ’95 onwards right up to Vista and is supplied 
in a single self-extracting file: ‘QE32-001.exe’. This self-extracting file will automatically guide you through 
program installation, upgrade, or removal. 

See: Program installation, upgrade, and removal of the QuikEC3 User’s Guide. 
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QuikEC3 release 0.02                                                                        03-05-07 
 

QuikEC3 release 0.02 runs under all versions of Windows from ’95 onwards right up to Vista and is supplied 
in a single self-extracting file: QE32-002.exe. This self-extracting file contains a Setup program that will au-
tomatically guide you through program installation, upgrade, removal and registration. 

See: Program installation, upgrade, and removal of the QuikEC3 User’s Guide. 

The changes in this release are as follows: 

QuikEC3 and its Setup program are modified to address the security changes in Microsoft’s new Vista operat-
ing system. Under Vista by default programs run with reduced privileges. That is to say that they are not per-
mitted to write to sensitive parts of the computer.  

The changes necessary to QuikEC3 fall into two categories. 

1. Program settings that were stored on a ‘per computer’ basis are now stored ‘per user’. 

2. Functions that were carried out by the Quiksoft applications are now carried out by the Setup program.  

Under Vista’s User Account Control the Setup program will require an administrator’s password. It will then 
run with the necessary privileges to make changes to the computer. (you don’t have to logged in as adminis-
trator). 

The Setup program has new options to unlock QuikEC3 as a Demo, Full copy, or major new release. 

For network installations the old QuikNet program used for setting the number of concurrent users is now ob-
solete and replaced with a new ‘Network server setup’ option available on the second page of the Setup pro-
gram. 

A further benefit is that QuikEC3 will now run under a limited user account with Windows XP. 
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QuikEC3 release 0.90                                                                        22-05-07 
 

QuikEC3 release 0.90 runs under all versions of Windows from ’95 onwards right up to Vista and is supplied 
in a single self-extracting file: QE32-090.exe. This self-extracting file contains a Setup program that will au-
tomatically guide you through program installation, upgrade, removal and registration. 

See: Program installation, upgrade, and removal of the QuikEC3 User’s Guide. 

This is the first version of QuikEC3 complete with its on-line help system. 

The changes to QuikEC3 are as follows: 

1. QuikEC3 now has a working context sensitive on-line help system. 

2. Non-symmetrical slender sections should be checked with additional moment due to the shift in neutral 
axis of the equivalent section (eNy, eNz). These are now correctly calculated under pure axial load. QEC-
R0.90-01 

3. The headings for the factors for reduced value of moment under axial load are brought into line with Eu-
rocode’s axis system. QEC-R0.90-01 
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QuikEC3 release 0.91                                                                        16-07-07 
 

QuikEC3 release 0.91 runs under all versions of Windows from ’95 onwards right up to Vista and is supplied 
in a single self-extracting file: QE32-091.exe. This self-extracting file contains a Setup program that will au-
tomatically guide you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal of the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. When a new user first runs a Quiksoft application the application will request a location for the project 
folder. QEC-R0.91-01 

2. When a new user first runs QuikEC3 the existing ‘per machine’ registry settings are copied to his ‘per us-
er’ system registry and the example files are copied to ‘NoProj’ in his project folder. QEC-R0.91-01 

3. QuikEC3 is now supplied with a vista aware manifest file that turns off virtualization. Virtualization is a 
Microsoft Vista feature that enables non-Vista applications to run under a standard user account. Howev-
er, it can lead to incorrect application behaviour particularly when older versions have been installed. 
QEC-R0.91-01 
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QuikEC3 release 0.92                                                                      20-08-07 
 

QuikEC3 release 0.92 runs under all versions of Windows from ’95 to Vista and is supplied in a single self-
extracting file: QE32-092.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. A new Network Server Setup option is added to QuikEC3’s Setup program and the old option renamed 
Network Server Tools. The new option requests that the installer select a location on the server for the li-
cense folder. Applications now check that the program folder and license folder are on the same drive. 
Setup-R1.50-1 

2. QuikEC3’s Setup program now has stronger validation for the program installation path. This should 
avoid problems where the user types bad characters. Setup-R1.50-2 

3. Within QuikEC3’s setup program entering bad characters for the program group name could cause a 
crash later in the install. The Setup program now properly validates the program group name. Setup-
R1.50-3 

4. QuikEC3’s zoom font buttons did not work. Fixed. This fault also caused some other check boxes to fail. 
QEC-R0.92-01 
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QuikEC3 release 0.95                                                                       01-04-08 
 

QuikEC3 release 0.95 runs under all versions of Windows from ’95 to Vista and is supplied in a single self-
extracting file: QE32-095.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

Please note that at the time of writing the UK National Annex is not published. 

The changes to QuikEC3 are as follows: 

1. The Setup program is modified following problems with installation on Network servers. QEC-R0.92-03  

2. When running under Microsoft Vista or Windows XP with restricted user privileges, selecting the 
File|Paper setup option could cause an error message. Fixed. QEC-R0.92-03  

3. Options are added to the File menu to cover the National Annexes. QEC-R0.92-05  

4. An error in the calculation of Mcr as displayed when clicking on the View calculations button in the Elas-
tic critical moment for lateral torsional buckling form is fixed. The value of C2 was taken as C3. The 
value of Mcr used elsewhere was unaffected. QEC-R0.92-02 

5. The chosen method for calculation of elastic critical moment for lateral torsional buckling (Mcr) is de-
pendent upon the section symmetry. For doubly symmetrical (as opposed to mono-symmetrical) sections 
QuikEC3 now looks for just Y symmetry not Y and Z. Hence channel sections are now treated as doubly 
symmetrical QEC-R0.92-04 

6. The clarity of the Elastic critical moment for lateral torsional buckling form is improved. QEC-R0.92-06  

7. There are small internal changes to the calculations of the Kij factors to match those required for 
Quikframe. These changes have no effect on program output. QEC-R0.92-07 
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QuikEC3 release 0.96                                                                       09-06-08 
 

QuikEC3 release 0.96 runs under all versions of Windows from ’95 to Vista and is supplied in a single self-
extracting file: QE32-096.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

Please note that at the time of writing the UK National Annex is not published. 

The changes to QuikEC3 are as follows: 

1. A File|Save As ASCII Text option is added. This option writes a simple ASCII text file containing the 
contents of the section table as displayed within the Properties tab. The default location for the file is the 
user's desktop. The file can then be loaded into Window’s Notepad and printed. See Help. QEC-R0.96-01 

2. The File|Export option is added. This option will automatically export section files to other installed 
Quiksoft programs. See Help. QEC-R0.96-02 

3. Box sections - The Change form now has fields for internal and external radii. Previously these where au-
tomatically calculated based on simple rules based upon the material thickness. However new Corus Cel-
sius355 and Jumbo355 sections complicate matters having differing specifications. QEC-R0.96-03 
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QuikEC3 release 1.00                                                                       03-02-09 
 
QuikEC3 release 1.00 runs under all versions of Windows from ’95 to Vista and is supplied in a single self-
extracting file: QE32-100.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. The UK national annex is now published. As expected, this overrides the simplified table 3.1 in               
EN 1993-1-1:2005 suggesting instead values from the relevant product standard. QuikEC3 now has op-
tions in its national annex section to choose values of fy from either Table 3.1 or the product standards. 
Note that the situation with fu is less clear since different values are published for steel types with the 
same strength designation. The Quiksoft programs always use the lowest value of fu published in either 
Table 3.1 or the product standard. QuikEC3 now includes additional steel grades (S235, S275, S355, 
S420, S450, S460). QEC-R0.97-01  

2. The UK national annex overrides Table 6.5 of EN 1993-1-1:2005. QuikEC3's UK national annex options 
and program logic are modified to suite. Note that as well as overriding Table 6.5, the UK national annex 
also implies that hollow sections, angles etc. should be treated as 'rolled' sections and formula (6.57) used 
for the calculation of XLT. QEC-R0.97-02  

3. UPE and UPN sections tables added. QEC-R0.97-03  

4. Under the combined buckling tab, clicking on the Factors kij button, selecting Method 2 and entering zero 
moments could cause QuikEC3 to crash. This revealed a slight logic problem in our implementation of   
EN 1993-1-1:2005's Table B.3. Fixed. QEC-R0.97-04 

5. Similar to above but Method 1. Entering zero for M(x) could cause QuikEC3 to fail. See EN1993-1-
1:2005 Table A.2. QuikEC3 now ensures that values for M(x) are non-zero. QEC-R0.97-04 

6. A fault in the calculation of shear area for welded box sections (minor axis) is fixed. The fault caused 
QuikEC3 to stop with the error message: 'EC3.pas Error 10'. Note that all similar calculations have also 
been checked. QEC-R0.97-05 

7. Right clicking when the section properties are displayed displays a popup menu. Selecting Insert before, 
Insert after, or Change displays a form where new sections are created or existing sections modified. 
Each section shape has its own form. These forms now contain better validation for user input data:- 

a) Check that section type is not blank. 

b) Check that section serial is not blank. 

c) To avoid problems in other Quiksoft applications QuikEC3 now checks that the reserved 'Default se-
rial names' have not been used. 

d) Checks to ensure widths and thicknesses etc. are non zero. QEC-R0.97-06 

8. Moving the mouse over the section properties column headings displays help hints. These hints offer a 
description, EC3 symbol, BS5950 symbol and units. In prior releases these hints where always on. They 
can now be turned off using QuikEC3's View|Show hints menu option. QEC-R0.97-07  

9. A new View|Show translations to BS5950 option is added. This option further controls the help hints de-
scribed in the previous item. By default, the help hint that translates EC3 symbols to BS5950 is now off. 
Use this option to turn it back on. QEC-R0.97-08 
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QuikEC3 release 1.01                                                                       16-06-09 
 

QuikEC3 release 1.01 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-101.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal and registration. 

See: Program installation, upgrade and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. The factor ’’ used for the section classification of Class3 and Class4 webs was wrongly calculated. 
Fixed. QEC-R1.01-01 

2. When classifying an ‘I’ section about its weak axis it is considered normal to ignore it's web. QuikEC3's 
logic did this by detecting that it contained the neutral axis and was therefore in 'part tension'. However 
this logic alone was problematic in that some sections may contain the plastic neutral axis within their top 
flange (Slim floor beams). To not consider a top flange or top plate as a compression element is plainly 
wrong. Release 1.00 of QuikEC3 addressed this problem by assuming that elements above the elastic 
neutral axis where in ‘Compression’, below ‘Tension’ and containing were ‘Part tension’. It then only 
classified ‘Compression’ elements. It did not however adjust the elastic neutral axis for axial load and up-
on reflection this was considered to be less than ideal. 

QuikEC3 is modified as follows: elements are now flagged as ‘Compression’, ‘Tension’ or ‘Part tension’ 
based upon the location of the sections plastic neutral axis modified for axial load. 'Compression' ele-
ments are always classified as such. By default, ‘Part tension’ elements are dealt with as compression el-
ements. However, ‘Part tension’ elements belonging to I sections and tees bending about their weak axis 
are not classified. QEC-R1.01-02 

3. A fault in the calculation of the interaction factor kyz used for combined buckling (Method 1) is fixed. 
QEC-R1.01-03 

4. QuikEC3 is installed along with four data files containing examples. Two of these (taken from Gardner 
and Nethercot's blue book) referred to an RHS section whose description was changed during an update. 
Fixed. QEC-R1.01-04 
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QuikEC3 release 1.02                                                                       20-10-09 
 

QuikEC3 release 1.02 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-102.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. A fault is fixed in the calculation of reduced elastic modulus for class4 (slender) sections. The fault only 
presented when the routine was used to calculate reduced modulus for a non class4 section where the di-
mension from the neutral axis to the extreme fibre was not initialised properly. Fixed. QEC-R1.02-01 

2. The calculation for Rho EN1993-1-5:2005 4.4(2) has changed between the final draft and published 
standard. Upon examination it seems very unlikely that there would be any difference in the calculated 
value. QuikEC3 is now updated. QEC-R1.02-01 

3. Combined capacity check for asymmetrical slender sections - Although the actual result was correct the 
presentation of the intermediate results failed to include any additional moment due to the shift in the 
elastic neutral axis. Fixed. QEC-R1.02-01 

4. Again, combined capacity: where there is high shear QuikEC3 adopts the equation in EN1993-1-1 (6.2). 
For class4 (slender) sections it uses equation (6.44). QuikEC3 is now changed slightly, for the purposes 
of this capacity check, its definition of a slender section no longer considers its classification under pure 
axial compression.  

 A UB carrying high shear should be checked using equation (6.2) otherwise the high shear is not account-
ed for in the combined capacity check. However, many UB sections when classified for pure compression 
have class4 webs causing the old QuikEC3 to apply the combined capacity check for slender sections 
(6.44). QuikEC3 now applies (6.2).  QEC-R1.02-03 

5. The combined capacity check for class4 sections carrying high shear is modified slightly. In the applica-
tion of the formula (6.44) the values of reduced elastic modulus will be further reduced to account for the 
high shear. See: EN1993-1-1 (6.29). Where such a reduction is applied QuikEC3 now produces an ex-
planatory message. QEC-R1.02-04  

6. Shear capacity Z axis. Where QuikEC3 applied the elastic shear check it would always report the result as 
being 'Low shear'. The fault was in the output only, the internal code and subsequent checks were correct. 
QEC-R1.02-05  

7. The development of Quikjoint for Eurocode required extensions to the National annex form. These are in-
cluded in this release of QuikEC3. QEC-R1.02-06  
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QuikEC3 release 1.03                                                                       16-02-10 
 

QuikEC3 release 1.03 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-103.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. Error in units under Beam LT tab. 'kN' should have read 'kN.m.'  QEC-R1.03-01 

2. Hot finished circular hollow section - the selection of the strut curve (Table 6.2) with regard to the steel 
grade was the wrong way around. Fixed. QEC-R1.03-02 

3. Again, strut curve - Angle sections now use curve 'b' rather than 'c'. QEC-R1.03-02 
 

 

 

 

 



QuikEC3 User’s Guide 

Software notice xiii 

QuikEC3 release 1.04                                                                       03-06-10 
 

QuikEC3 release 1.04 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-104.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. Each Quiksoft program now shows the currently selected national annex in its title bar. e.g. 'QuikEC3 - 
National annex: UK - [Brit.sec]'.  QS  Cap-01 

2. QuikEC3's Calculations tab now includes an option to display the selected National Annex's values. 
These will also be available in the printout.  

3. The printout now includes a drawing of the selected section profile showing its orientation. QS  Cap-02 

4. On occasions Quiksoft programs have encountered errors reading section files. These have been due to 
poor versioning or user error and usually take the form a message: 'Attempt to load unregistered              
ClassID=????'. The programs are now modified so that the error message contains a path to the offending 
file. QB  R4.01-01 
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QuikEC3 release 1.05                                                                       28-01-11 
 

QuikEC3 release 1.05 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-105.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. Changes to cover Eurocode 3 Corrigenda February 2006 and April 2009 (AC1 and AC2). AC1 has no ef-
fect, the changes for AC2 are as follows: 

a) Table 3.1 (page 26) values for fu changed. No affect in UK as national annex uses the product stand-
ard. No changes made. EC3-AC2-a  

b) Table 5.2 (page 44) classification of angles. ':' becomes 'and'. Program checked; no changes neces-
sary. EC3-AC2-b 

c) Clause 6.2.6(3)c) (page 51) shear area of Tee sections. Quikframe updated. EC3-AC2-c 

d) Clause 6.2.9.1(6) (page 55) CHS sections - definition of 'n', Mn,y,Rd and Mn,z,Rd. No changes made, ex-
isting method gives very similar results. EC3-AC2-d      

e) Clause 6.3.2.3(2) (page 62) definition of XLT,mod and 'f'. The Quiksoft programs do not use this reduc-
tion. EC3-AC2-e 

f) Table A.1 (page 76) formula for npl. Program modified. EC3-AC2-f 

g) Table A.1 (page 76) formula for Czz. Program modified. EC3-AC2-g 

h) Table A.1 (continued) (page 77) definition of Cmi,0 and C1. Checked no changes required. EC3-AC2-h 

i) Table B.3 (page 80) last formula in table '-' becomes '+'. Program modified. EC3-AC2-i  

j) Formula (BB.5) (page 85) Definition of C1. Checked no changes necessary EC3-AC2-j  

k) Formula (BB.9) and (BB.10) (page 88) Definition of C1. Checked no changes necessary. EC3-AC2-k 

l) Figure BB.4 (page 90) definition of Betat. Checked no changes necessary. EC3-AC2-l   

Where these changes impact on the program's results, the calculations are marked thus: <AC1 

2. The summary of input under the Calculations tab was not properly representing the buckling lengths of 
single angles and square hollow sections. Fixed. QEC-R1.04-01 

3. Selecting a class 4 (slender) CHS section could case an error: EC3SectionTools.pas 4. Fixed.             
QEC-R1.04-02 

4. QuikEC3's on-line help and manual are updated. 
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QuikEC3 release 1.06                                                                       01-07-11 
 

QuikEC3 release 1.06 runs under all versions of Windows from ’95 onwards and is supplied in a single self-
extracting file: QE32-106.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

See: Program installation, upgrade, and removal in the QuikEC3 User’s Guide. 

The changes to QuikEC3 are as follows: 

1. The following additional options are now added to the Help menu: 

a) Visit the Quiksoft website: This option opens the Quiksoft home page on the web. 

b) Check for latest updates: This option displays a 'Check for latest updates' form. The form will connect 
to the Quiksoft website and advise if program updates are available. QS-WS-1 

2. The Quiksoft programs have encountered problems with compiled HTML help systems (.chm files) run-
ning over networks due to Microsoft enforced security issues. The recent release of Internet Explorer 9 
has made the situation even worse. Hence at start-up the program will now copy the entire help file from 
the server to a temporary folder on the client. The help system is then run locally. This should resolve all 
known HTML help issues. QS-HLP-1 

3. Upgrading to a new release will now require a code when the digit immediately after the decimal changes 
e.g. Upgrading from 7.01 to 7.09 will not require an upgrade code. Upgrading from 7.09 to 7.10 will re-
quire a code. This does mean that release codes will be required more frequently, but better fits our re-
lease strategies since the effected releases often contain considerable enhancement. QS-UPG-1 
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QuikEC3 release 1.10                                                                       26-06-12 
 

QuikEC3 release 1.10 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-110.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to QuikEC3 are as follows: 

1. Support for operating systems older than Windows XP is now withdrawn. 

2. Modifications to enhance software security. QS-23-08-11 QS-18-10-11-1     

3. The Quiksoft programs show the currently selected national annex on their main window caption. How-
ever, where the national annex had not been selected the programs showed a blank. Now before a national 
annex is selected the caption shows 'National annex: Box' and until a new national annex is selected the 
Box values will be used in any Eurocode calculations. QS-26-08-11-2 QS-18-10-11-2  

4. Value of Alphacc for the UK national annex for EN 1992-1-1 was taken as 1.00 but should have been 
0.85. Also, typo in National Annex change form corrected. Note that this value is not used by any pro-
gram other than Quikjoint. QS-14-12-01-1 QJ R7.40-53 

5. All Quiksoft executable downloads and applications are now digitally signed using Microsoft Authenti-
code. For additional security the Quiksoft applications now check that the signature is intact and that the 
executables have not been altered or corrupted. QS-11-04-12-1 

6. QuikEC3's Help|About form now displays the file signature status. QS-11-04-12-1 

7. All Quiksoft executable files now have extended manifest files. The WinZipSE program used to produce 
the self-extracting installation file is updated to release 4.0. These changes should avoid the message: 
'This program might not have installed correctly' after installation. QS-23-04-12-1 QS-23-04-12-2 

8. Changes to network licensing to simplify deletion of logged on users - On start-up, networked copies of 
the Quiksoft programs count the number of copies already in use (logged on users). If these exceed the 
number of concurrent licenses a warning is produced, however from time to time because of system 
crashes users could remain logged on. This can be repaired by rerunning the Setup program and selecting 
Network server tools and Log off users. However, now the problem can be fixed more directly from with-
in each application by selecting a new 'Log off users' button displayed within the Licence error form. 'Log 
off users' now produces a report showing each file deletion. QS-25-04-12-3 

9. The default name and address for new users used to be loaded from Quiksoft.ini in the user's Windows 
folder. Quiksoft.ini is a legacy 16bit windows file and will no longer be used. The default username and 
address is now obtained from the program source code. QS-27-04-12-4 

10. The Quiksoft Setup program no longer copies Quiksoft.ini into the user's Windows folder. This file was 
used by the old 16bit Quiksoft programs, which are no longer supported. QS-27-04-12-5 

11. The Quiksoft logo displayed by the Setup program is modernised. QS-27-04-12-6 QS-02-05-12-8 

12. The Quiksoft logo displayed in QuikEC3's introduction form is modernised.                                           
QS-27-04-02-7 QS-02-05-12-8 

13. When first run, before the user's project folder was set, the Quiksoft programs sometimes created an emp-
ty folder: c:\quiksoft data\quikec3. Fixed. QS-08-05-12-9 

14. QuikEC3's Main window now has improved fonts. QS-08-05-12-10 

15. The Quiksoft Setup program is extensively modified to automate network installations. QS-18-06-12-01 

16. On start-up, if the licence folder is missing the Quiksoft programs now issue an error: License folder: 
<Path> is missing'. Prior to this they would report: 'There is a copy of Quik??? already running'.           
QS-18-06-12-02 
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17. The section in the manual and on-line help covering program installation is removed and replaced with a 
link to the Quiksoft web site QS-18-06-12-03 
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QuikEC3 release 1.11                                                                       29-01-13 
 

QuikEC3 release 1.11 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-111.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Users are advised to upgrade immediately, see item 1.   

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to QuikEC3 are as follows: 

1. For doubly symmetrical I sections and channels the effects of axial load on moment capacity can be ig-
nored provided that the criteria described by formulas (6.33), (6.34) and (6.35) of EN 1993-1-1 are met. 
Unfortunately, the program omitted to use the absolute value of NEd causing the combined effect of axial 
tension and moment to be ignored. Axial compression and bending were dealt with correctly. Fixed. QS-
29-01-13-01 

2. QuikEC3's installation now includes Australian sections. See: 
www.quiksoft.co.uk/component/content/article/74 

3. The Help|About form is modified with more detailed text, plus a link to the Quiksoft web site. QS-08-11-
12-01 
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QuikEC3 release 1.12                                                                       19-06-13 
 

QuikEC3 release 1.12 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-112.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to QuikEC3 are as follows: 

1. Table B.3 of EN 1993-1-1 - Calculation of Cmy, Cmz and CmLT. These values are used in the calculation of 
the kij factors for combined buckling checks. When making the decision to use either as (Case 2) or ah 
(Case 3) the program failed to use the absolute value of the moment Mh causing an incorrect value to be 
selected. Fixed. QS-03-06-13-01 

2. The Quiksoft programs have an option to list the values of the selected National annex. Unfortunately, the 
values for the 'Box' national annex were displayed incorrectly. Note this affected the display of the Box 
national annex values only, all calculations were correct. QS-05-06-13-01 

3. Under QuikEC3's 'Beam LT' tab the following sequence caused the old rather than new value of 'L' to be 
used: Enter a new value of 'L', click 'Mcr...' and in the 'Elastic critical moment for lateral torsional buck-
ling' form click 'View calculations'. The value of L used in the final calculations would be correct.  Fixed. 
QEC-R1.12-01 
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QuikEC3 release 1.13                                                                       18-07-13 
 

QuikEC3 release 1.13 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-113.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to QuikEC3 are as follows: 

1. An unusual error is fixed affecting the combined buckling check of single channel sections with bi-axial 
bending and zero axial load. The combined buckling checks for these Mono-symmetric sections are sup-
posed to use elastic properties. See SN030a-EN-EU. Unfortunately, where a channel section carried zero 
axial load it was possible for QuikEC3 to wrongly calculate and use Wpl,y,eff as described in 6.2.2.4(1) of 
EN 1993-1-1 Fixed. QS-17-07-13-01 
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QuikEC3 release 2.00                                                                       21-05-14 
 

QuikEC3 release 2.00 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-200.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to QuikEC3 are as follows: 

1. The Quiksoft programs are no longer unlocked by the Setup program. Instead unlock codes are requested 
at program start-up. QS-29-10-13-01 QS-05-11-13-02 QS-21-11-13-03 

2. For network copies QuikEC3's Help menu now includes a 'Network licence settings' option. The new op-
tion covers administration options for concurrent network copies. QS-30-10-13-03 QS-30-10-13-04 

3. The Quiksoft installation copied Setup.exe into each applications program folder. On network server in-
stallations this could be started to quickly perform a setup on a client computer. Unfortunately, many us-
ers were confusing it with the full Setup program. It is now more correctly named 'ClientSetup.exe'. QS-
05-11-13-01 QS-05-11-13-03 QS-08-11-13-04 

4. The Quiksoft program's Browse For Folder form was found to be unreliable when browsing deep directo-
ry structures on a network server. It is replaced with the standard windows form. QS-08-11-13-05 

5. The program's introduction form displayed for demonstration copies is generally improved and now in-
cludes number of days remaining. QS-25-11-13-05 QS-08-01-14-04 

6. The Quiksoft Help|About form now displays the latest Quiksoft logo. QS-12-05-14-01 

7. The Setup program and program introduction form's now display the new Quiksoft banner logo. QS-12-
05-14-02 QS-21-05-14-04 

8. Using Method 1 for the calculations of kij factors for combined buckling, the formula taken from Table 
A.2 of EN1993-1-1 (case 2) for Cmi,0 was presented wrongly as '1.0(' rather than '1.0 +'. Note the actual 
calculations performed were correct, only the representation of the formula in the on screen and printed 
output were wrong. QS-15-05-14-03 

9. QuikEC3's File menu now contains a Project manager option. This brings QuikEC3 into line with other 
Quiksoft programs. QEC-R1.13-01 QEC-R1.13-02 

10. The File|Settings|Load option now loads the sections file in use when the settings were stored. QEC-
R1.13-03 

11. The File menu now has a Reopen menu option. This provides a means to re-open recently used sections 
files. QEC-R1.13-04 

12. QuikEC3's Online help and manual are updated. 
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QuikEC3 release 3.00                                                                               14-08-2020 
 

QuikEC3 release 3.00 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-300.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

 

1. Changes to the operation of the 'Paper setup'. The Title can still be changed here, but rather than being 
a separate title, it is now the same as the project title. This is more logical since the options 
‘File|Settings|Load’ and ‘File|Settings|Store’ default to the location of the project folder used by the 
other Quiksoft programs. QEC-R2.00-01 

2. Slight modification to ensure that QuikEC3's main window opens in a visible region of the screen. 
QEC-R2.00-02 

3. In prior versions of QuikEC3, the standard sections files (Brit.sec, Euro.sec etc.) where opened from 
the program installation folder. In modern window's this folder is strictly read only. This made 
reading and writing section files less than convenient. QuikEC3 now copies these files to the program 
data directory on startup (it will not overwrite existing files). The default location for this folder under 
Windows 10 is: "C:\Users\<User name>\Documents\My Projects\Quiksoft data\QuikEC3". The 
transition to this system should be seamless, but users may wish to make this the default location for 
all their QuikEC3 created custom section files. QEC-R2.00-03  

4. On the Strut and Calculations tab for Circular hollow sections, under the list of inputs QuikEC3 
published a value for ‘Lcr,T’. This is not relevant to the calculations for circular hollow sections and is 
now removed. QEC-R2.00-04 

5. QuikEC3 now has two additional speed buttons on its toolbar. As well as providing fast access we 
hope this will clarify the difference between saving a created sections file and storing the current state 
of the program along with entered forces, effective lengths etc. QEC-R2.00-05 

6. The ‘File|Settings|Load’ and ‘Store’ options and the new speed buttons save the settings to the current 
project folder. However, there were circumstances where switching projected folder failed to switch 
the folder offered in the Load and Store forms. Fixed. QEC-R2.00-06 

7. QuikEC3’s 'File Open' and 'File Save as' forms are now sizable.  

8. Project handling - On rare occasions users were experiencing problems when their selected project 
folder became invalid. It can become invalid after changes using Windows file explorer (renaming, 
moving, or changes to folder access permissions). The project folder and program data folder are now 
checked just after program start-up. If the Quiksoft programs detect a problem, they display a 
warning with a ‘Help’ button that will give information and a remedy. QS-10-10-17-01 

9. Prior to registering as a fully licenced copy the Quiksoft programs display an introduction form. The 
forms main function is to accept codes to unlock the software. This form now displays the program 
release number. QS-26-01-18-01, QS-12-12-18-01   

10. The customer name and address default is now Quiksoft Limited with contact details.                      
QS-19-07-18-01 

11. The introduction form for trial copies now includes a link to the 'Buy now' page of the Quiksoft 
website, displayed only when the remaining free trial days falls below seven. The same form now 
includes better advice (hint text) on how to copy and paste the serial number to email. The popup 
menu is also improved. QS-19-11-18-01   

12. QuikEC3 now automatically checks the Quiksoft website to see if updates are available on start-up. 
The check is made every other time the software is started. If updates are available a form is 
displayed with access to a direct download link and full instructions. There is also a Snooze option.    
QS-07-03-19-01 
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13. The existing form ‘Check for latest updates’ available from the ‘Help’ menu is uprated to give access 
to the same direct download link and instructions. The form also provides an option to turn the 
automatic check off. QS-07-03-19-01 

14. File handling routines are modified to handle file names containing '.'. Over the years file naming 
convention has changed. It was originally assumed that file names would only contain a single '.' and 
that all characters after would be the file extension. However, this seems no longer to be the case. 
That said we would still advise that as far as possible this be avoided. It is likely that it could cause 
problems when transferring files to other programs and operating systems. We have found here that 
servers that use Unix derivatives (NAS drives, Android, Apache etc.) have differing standards. We 
have also tested using a folder path containing '.' mimicking an IP address with no problems detected.                                           
QS-05-06-19-02 

15. Dual monitor systems - When running on the second monitor QuikEC3 could display some forms on 
the primary monitor. Fixed. QS-05-04-19-01, QS-08-04-19-01 

16. Additional code is added to detect when a form is displayed 'off screen' and move it back to a visible 
area. Because the Quiksoft programs 'remember' some window and form positions, they could have 
previously been displayed on a second monitor that has been disconnected. This caused the form to 
be displayed 'off screen' leading customers (and us!) to believe the program had become 
unresponsive. On the occasions this was reported it involved the scrolling calculations form in 
Quikjoint. Fixed. QS-08-04-19-01 

17. QuikEC3 now includes the option to use your company logo in place of your address text on the 
printed output. See the 'Addresses' option available on the 'File' menu, and via right clicking on the 
results preview page and selecting 'Results headers' on the popup menu.  QS-27-07-19-01 

18. QuikEC3’s on-line help and manual are updated. 
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QuikEC3 release 3.01                                                                               23-08-2020 
 

QuikEC3 release 3.01 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QE32-301.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

 

1. It is possible in QuikEC3 to turn the toolbar off using the 'View|Toolbar' option. Unfortunately, this 
was broken by the changes detailed in item 5 release 3.00. Fixed. MER-R5.40-2 

2. There was a very slight glitch reading settings files. Reading a settings file that was intended for Mer-
lin caused the default sections file path to be used. However, the default path was still set to point to 
the program folder. Fixed. See item 3 in release 3.00 above. MER-R5.40-4  
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QuikEC3 release 3.50                                                                      18-04-2023 
 

QuikEC3 release 3.50 runs under all versions of Windows from XP onwards including Windows 10 and 11 
and is supplied in a single self-extracting file: QE32-350.exe. This self-extracting file contains a Setup pro-
gram that will automatically guide you through program installation, upgrade, removal, and registration. 
Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

The changes to QuikEC3 are as follows: 

1. QuikEC3 is now supplied with an updated ‘Advance.sec’ sections file with additional sections from Brit-
ish Steel. QS-08-11-22-02   

2. QuikEC3 contacts the Quiksoft website to check for new releases and provides links and help text to fa-
cilitate easy upgrades. The text now advises contacting support@sigma-x.net. QS-08-11-22-03   

3. Modifications to the ‘Setup’ program to fix a Windows 10/11 fault in the operation of 'Add or Remove 
programs'. QS-18-01-23-06   

4. Corresponding modifications to the Quiksoft ‘Uninstall’ program. The ‘Uninstall’ program now simply 
shows a message advising that program removal be carried out via the original setup program.              
QS-18-01-23-07   

5. The form displayed when 'About' is selected on the 'Help' menu is improved (cosmetic). QS-20-01-23-08 

6. Steel design to Eurocode Clause 6.33 and 6.34 - Where axial is low it can be ignored, and we use NRd ra-
ther than the reduced value. Unfortunately, QuikEC3 was reporting NEd. Now corrected to NRd. Note that 
the calculations were correct. QEC-R3.01-01  

7. Similar problem to the above for bending about the Z axis. Fixed. QEC-R3.01-02 

8. QuikEC3’s help system and manual are updated. 
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QuikEC3 release 3.51                                                                      06-06-2023 
 

QuikEC3 release 3.51 runs under all versions of Windows from XP onwards including Windows 10 and 11 
and is supplied in a single self-extracting file: QE32-351.exe. This self-extracting file contains a Setup pro-
gram that will automatically guide you through program installation, upgrade, removal, and registration. 
Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

The changes to QuikEC3 are as follows: 

1. Unfortunately release 3.50 of QuikEC3 contained a fault. Viewing the calculation for the kij factors used 
for combined buckling checks could result in the following error message: RichTemplate.pas Template 
id=’Cmi0Case1’  CurField>FieldList.Count. 

This was due to a supplied resource file being truncated. The file is compiled by our own in-house soft-
ware which has been modified to check the files integrity before release. QS-05-06-23-01 

 


